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Overview

The SC-7400 family of four-wire transmitter/alarm signal conditioning
products are field rangeable and fully configurable with a Hand Held
Communicator (HHC) or direct connection to a Personal Gomputer (PC).
The SC-7400 will accept a wide variety of process inputs of mV, V, T/C,
mA, RTD's, ohms and slidewires. The input circuitry is designed for
intrinsic safety, although not all units are available in intrinsically safe
versions. Intrinsic safety reduces the risk of ignition by electrical
apparatus or connecting wiring in hazardous locations. Output ranges are
also selectable for each model. All input/output ranging is done through
the front access connector with a HHGC or PC.

The units are compact, lightweight and provide space-saving mounting.
The SC-7400 transmitters are mountable on standard DIN rail or can be
surface mounted. The power supply is jumper selectable for a wide range
of power sources.
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Figure 1 - SC-7400 Dimensions



Available Models

The following is a list of the avaitable SC-7400 models. The N after
the model number denotes non-intrinsically safe model and the |
indicates intrinsically-safe model.

Model Number

SC-7401-N
SC-7401- 1

SC-7402-N
SC-7402-|
SC-7402-N-100

SC-7403-N
SC-7403-|

SC-7404-N
SC-7404-1

SC-7405-N
SC-7405-|

Qutput Type

Single analog output
Single analog output, intrinsically safe input

Dual analog output
Dual analog output, intrinsically safe input
Dual analog output, 0 -100 mV fixed input

Single trip/alarm output
Single trip/alarm output, intrinsically safe input

Dual trip/alarm output
Dual trip/alarm output, intrinsically safe input

Single analog and single trip/alarm output
Single analog and single trip/alarm output,
intrinsically safe input.



Installation

Installation personnel should have a general electrical and
mechanical maintenance background. Installation of this equipment
does not require special training or equipment, however standard
instrumentation installation practices must be observed.

Unpacking

Upon receipt of the equipment, perform the following procedures:

Inspection

Check alt containers for signs of external damage.
Look for scratches, protrusions, holes, smashed
corners or rattles.

Ensure that the container is sealed. If any container is
open, notify the carrier and record it on the freight bill.

Open the container and check the contents against the
respective packing list.

Save all packing containers and materials for possible
reshipment.

Inspect the outside of the equipment for damage such
as scratches, dents, cracks, etc.

Record any damaged, missing or incorrect items.
Immediately notify the carrier and RiS Technical
Support. RiS Technical Support phone number is
located on the cover page of this manual.

ICAUTION!

‘DO NOT Attempt to install equipment with
obvious signs of physical damage. Contact your RIS After

Market Services Representative.




Repacking for Shipment

If the instrument is to be shipped to Rochester Instrument Systems,
Inc. for service or repair:

1

Call RiS Repair Sales and obtain an Return Material
Authorization (RMA) number.

Attach a tag to the instrument identifying the owner and
indicating the service or repair to be made. Include the model
number and full serial number of the instrument.

In all correspondence, identify the instrument by model
number and full serial number. Serial tag is located on the
housing.

Place the instrument in original container with appropriate
packaging material and secure with strong tape.

If the original container .is not used, do the following:

® Wrap the instrument in static resistant plastic before
placing in an inner container.

° Place packing material around all sides of the
instrument and cushion it with cardboard strips.

° Place the instrument in the inner container in a heavy
carton and seal with strong tape.

°. Mark shipping container "DELICATE INSTRUMENT",
"FRAGILE", etc.

o Mark the RMA number on the outside of the package.



Mounting,

The SC-7400 units can be mounted on a standard DIN rail or can be
surface mounted. A template is provided for easy mounting. For 240 Vac
mains service, allow 1/8" spacing between units for proper ventilation.
The template is located at the end of this manual on the same page as
the registration card. For DIN rail mounting the backplane snaps onto the
DIN rail. For surface mounting use #6 hardware to attach the backplane
to the surface. To connect the unit to the backplane insert the bottom of
the connector first and rotate the unit upwards. Refer to Figure 2.

For your convenience two blank labels are provided. The labeis can be
used on the top and front of the unit. The top label adheres to the top of
the transmitter case. The front label is positioned over the front connector
opening. Record your configuration information or any other pertinent
information on these labels. The labels can be removed and reused as
needed.

Figure 2 - DIN Rail Mount
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Figure 3 - Surface Mount



Jumper Selections for Power Supply

The SC-7400is jumper selectable for a wide range of power sources.
Acceptable supply voltages are 24 Vdc, 48 Vdc, 110 {(125) Vdc, 120 Vac,
and 240 Vac. To access the jumpers, disconnect the unit from the
backplane by pulling the unitina downward rotation as shown in Figure
4. The jumpers are located adjacent to the connector, as shown in
Figure 5.

Figure 4 - Jumper Location

The jumper settings for the power supply voltages are labeled above the
connector inside the transmitter. Place the two jumpers {provided) on the
corresponding pins. The illustration shows the jumpers on pins 1 and 4
indicating a selection of 24, 48, and 110 (125) Vdc as the power supply.

: Jumper
0 24dgn Iz | e = 2
e W Voltage Selection
oc 1o [ Guide
WAC| e ———

24, 48,110 (125) Vdc | 1 +4
120 Vac 2+4

240 Vac 3+5

Figure 5 - Jumper
Setting for DG Voltages



Wiring Recommendations

The following diagram shows the location of the terminal blocks and
LED's.

POWER

[VAVARNVAY i\ Y

INPUT

MODULE

TB3

ALARM 1 —— TB4

ALARM 2

CONFIGURE

//& TI2F

Figure 6 - Terminal Block and LED Locations

LED Indicatoi‘ Function

Power Green LED (on = OK)
Input {Sensor) Green LED (on = OK)
Module (CPU) Green LED (on = OK)
Alarm 1 Red LED (on = alarm)
Alarm 2 Red LED (on = alarm)




Noise Reduction

Use the following recommendations to reduce noise effects with the

SC-7400 family of transmitters.

® Use standard instrumentation installation practices.

® Use shielded wire for all analog signals, input and
output.

e For the best noise rejection, it is recommended that

you wire the input as shown in Figure 7.

° Figure 8 is the recommended output wiring diagram.
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Figure 7 - Input Wiring
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Figure 8 - Qutput Wiring
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Input Connection Diagrams

Use the following diagrams for connecting the desired input.

installation in hazardous locations see drawing 1072-477.
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Figure 9 - Inpui Diagrams
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Input Connection Diagrams (Continued)

3-WIRE DIFFERENTIAL RTD:

SC-7400-N

@QQ TB3
O O|C|O|| B4

O
O

Tz TE
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MV T/C:
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pQQ OOl 82
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VOLTS:
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0000 (| B3
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T2 T1
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SC-7400-1

NOT AVAILABLE

SC-7400-1

pOOO TE3

SC-7400-1

NOT AVAILABLE

Figure 10 - Input Diagrams
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Output Connection Diagrams

Use the following diagrams for conneciing the desired output.

installation in hazardous locations see drawing 1072-477.

SC-7401-N, SC-7402-M,
SC-7401-1, SC-7402-I:

OUTPUT 1 POWER

e, i,

+ . 12N (-}
Li(H)

,
GO OO m * JUMPER TB1-1 TO TB1-2 AND TB2-1 TO TB2-2
: FOR VOLTAGE OUTPUTS ONLY
R0 J0||m
+ .
e —
OUTPUT 2
(SC-7402-N, SC-7402-1 ONLY)
SC-7403 N, SC-7404-N,
SC-7403-1, SC-7404-L
QUTPUT1 POWER
LN
_i Iﬂ Li{y)
O OO 00| E1
1
Q OO T2 NOTE: RELAYS SHOWN IN
DE-ENERGIZED STATE.
1144
|| Il Y
S’

QUTPUT 2
(SC-7404-N, 5C-7404-1 ONLY)

SC-7405-N, SC-7405-T.

QOUTPUT 1 POWER

PN s,

" L2 )
L1{#)

» JUMPER TB1-1 TO TBI -2
Oj| 81 FOR VOLTAGE QUTPUTS ONLY

000
lQQQO'O TB2  NOTE: RELAYS SHOWN IN

DE-ENERGIZED STATE.

OUTPUT 2

Figure 11 - OQutput Diagrams
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Specifications

Indicators:

Power Supply:

Input Signals: '

Volt (Non IS Models):
Current (Non IS Models):
mV (All Models): '

T/C (All Models):

T/C Type
NIST J
NIST K
NIST E
NIST R
NIST S
NISTT
NIST B
DIN J
DINT
BS N (AWG 14)

Power - Green LED.

Input sensor - Green LED {on = OK).

Module CPU Operation - Green LED {on = OK).
Alarm 1 - Red LED (on = alarm).

Alarm 2 - Red LED (on = alarm).

Jumper selectable for 24 Vde, 48 Vdc, 110 Vdc,
120 Vac, or 240 Vac 50/60 Hz nominal.

0to 1V, Oto 5V,0to 10V, 1to 5V, 0to XV
(special factory configuration X=20 to 200V,
30V maximum for CSA)

0to 1mA 0to5mA, 1to5mA, 0to 10 mA,
Q0020 mA, 41020 mA, 10050 mA,Cto 5
mA Bipolar, 0 to 10 mA Bipolar

-15 to +85 mV absolute operating range.
Zero and span may be set anywhere within
range. 4 mV minimum span.

Software configurable for linearized or non-
linearized output.

Range °C  Min/Max Span
-180 to 760 110 10 940
-180 to 1300 140 to 1480
-150 to 1000 90 to 1150
0 to 1600 450 to 1600

0 10 1600 480 to 1600
-200 to 400 160 to 600
300 to 1800 650 to 1500
-200 to 900 110 to 1100
-200 to 600 160 to 800
0 to 1300 140 to 1300

1 SC-7402-N-100 does not have a configurable input. The input is factory setat 0 - 100

mV.



Ohms - 3 or 4 wires (All Models):

RTD - 2, 3 or 4 wire, 3 wire differential
for PT and Ni RTD, 2 wire only
for Cu RTD (All Models):

Slidewire (Non IS Models):

Analog Qutput Signals:

Trip Outputs:

0 to 500 Q absolute operating range. Zero and
span may be set anywhere within range. 50 Q
minimum span

100 ohm Pt @=0.003850, -200 to 850 °C

min span = 50 °C

100 ohm Pt o=0.003916, -200 to 850 °C

min span =50 °C

100 ohm Pt =0.003923, -200 1o 650 °C

min span = 50 °C

120 ohm Ni = -80 to 320 °C, min span 50 °C
10 ohm Cu = -200 to 260 °C, min span 460 °C

May be configured for 500 to 5000 ohm span
based at zero chms.

Software configurable current outputs:

0-1 mA

0- 5mA

0-10mA

0-20mA

4-20 mA
Voltage Outputs configurable through software
and external terminal block wire jumper {See
Qutput Connection Diagrams)

0- 1V
0- 5V
1- 5V
0-10V

Form C relays, failsafe or non-iailsafe.
One or two available, depending on Model
number.



Accuracy Related Factors

Input Accuracy:
mv:
V:
mA:
ohms (3 and 4 wire):

Pt, Ni RTD (3 and 4 wire):

Cu RTD (2 wire):
Slidewire:
T/C:

T/C Type
NIST J
NIST K
NIST E
NIST R
NIST S
NISTT
NIST B

DIN J
DINT

BS N (AWG 14)

Cold Jdunction Error:
Non-Linearized T/C:

Repeaiability:

Analog Output Accuracy:

+0.02% of reading £0.005 mV, Linear with input
+0.05% of reading 0.6 mV, Linear with input
+0.05% of reading +3.0 »A, Linear with input
$0.05% of reading £0.03 ohm, Linear with input

0.1% of reading £0.1 °C, Linear with temp.

+2.0 °C, Linear with temperature
10.1% of span, Linear with input
Accuracy listed in table plus cold junction error

Range °C

-180 to 760
-180 1o 1300
-150 to 1000

0 to 500
500 to 1600
0 to 500
500 to 1600
-200t0 0
0 to 400

300 to0 500
500 to 1800
-200 to 900
-200 to -100

-100 to 600

0 to 800

800 to 1300

10.5°C

Accuracy

+0.3°C
+05°C
+0.3°C
+1.0°C
+0.7 °C
+1.0°C
0.7 °C
+0.4 °C
+0.3°C
+20°C
+1.0°C
+0.3°C
0.4 °C
+0.3°C
+0.3°C
x0.5°C

+0.02% of reading +0.005 mV plus coid

junction accuracy.
0.05% of span

Range Accurac
0- 1mA £ 0.5%
0- 5mA +0.1%
0-10mA £ 0.05%
0-20 mA +0.05%
4 - 20 mA + 0.05%

0-1V +0.5%
0- 5V +0.1%
1- 5V +0.1%
0-10V * 0.05%

% of span



Tracking Accuracy (SC-7402 only):

Trip Output Accuracy:

Operating Influences

4 to 20 mA *0.5% max
others +1% typical

+ 0.01% of span (Input Accuracy rating must be
added to this figure to determine overall accuracy)

Input Reference Conditions:

mv:
T/C:
RTD:
Ohm:

Analog Output Reference Condition:

Ambient Temperature:
Nominal:
‘Operating Range:
Storage Range:
Effect on Accuracy:
for Current Input
for Copper RTD Input
Effect on Cold Jot:

Relative Humidity:

Range:

Effect on Accuracy:
Vibration Effect:

Range:

Effect on Accuracy:

Drop and Topple:

Oto 10 mV

0to 200°C "J" T/C

0 to 200 °C 100 Q Platinum
0to 100 Q

4 to 20 mA, 250 O load

23+1°C

2010 +70°C *

-40 to +85°C

+/- 0.005% / °C max.
+/- 0.0075% / °C max.
+/- 0.01% / °C max.
+/- 0.015°C / °C max.

25 10 95% non-condensing
+/- 0.075% of span for a change in RH of
2510 95% a1 23 °C

A constant displacement of 1mm over a
range of 5 to 15 Hz, an acceleration of
5 m/s/s over the range of 15 to 150 Hz
+/- 0.05% of span

+/- 0.05% of span

* Derate to 60°C for 240 Vac operation.



Output Load:

Output Resistance:
Common Mode Effect:
Normal Mode Effect:
Supply Voltage
Nominal:

Range:
Effect on Accuracy:

Magnetic Field Effect:

Electromagnetic Susceptibility:

SWC Protection:

ESD (electric discharge):

(Current outputs): +/- 0.05% of span for the
following load changes:

Range: Load:

1 mA 16000 O
5 mA 3200 0
10 mA 1600 O
20 mA 800 Q

(Voltage outputs): 1 kQ +/- 1.0%
120 dB at 250 Vac 50/60 Hz

40 dB with peak to peak signal within the
unit's maximum input range

24 Vdc, 48 Vdc, 110 Vdc, 125 Vdc
120 Vac 50/60 Hz, 240 Vac 50/60 Hz
+/- 15% '
+/- 0.05% of span over the range

+/- 0.05% of span at 0.5 mT, 50/60 Hz

+/- 1% of span over the frequency range of
20 to 1000 MHz at a field strength of
10V/M.

+ 2% of span over the frequency ranges of
50-55 MHz, 150 MHz, and 95-115 MHz at a
field strength of 10 V/IM

Tested to: SAMA PMC 33.1-1978

Conforms to ANSI C37.90.1-1989 for
oscillatory and high frequency disturbance
withstand.

Conforms to IEC 801-4 Level 2

IEC 801-2 level 3 {8kV), No permanent
damage.



Functional Characteristics

Analog Output Step Response:

Trip Output Step Response:

Contact Rating (irip outputs):

Trip Range:
Deadband:
Delay:

Input Impedance
T/C, mV:
mA:

V:

RTD Excitation:
RTD Failure:

Open Lead:
Shorted RTD:

For a step of 0 to 100% of span the
10 to 90% response time is less than
0.5 second. The response time from
input change to 90% output change is
less than 1 second.

For a step of 0 to 100% and the delay
set to zero the trip will occur within 0.5
second.

3A, 250 Vac resistive or

3A, 30 Vdc, 30W max.

0.5 t0 100% of span in 0.1% increments
0 o 20% of span in 1% increments

1 to 120 seconds in 1 second
increments

Software configurable for trip level,
deadband, failsafe or non-failsafe
operation, high going or low going
trip/alarm, trip/alarm delay, and
response to input failure.

Greater than 2 MQ
500 5%
500 KO + 5%

165 1A + 10%

Upscale

Downscale

INPUT {Sensor OK) LED turned off with
sensor failure. Failure is defined as 5%
over or under the selected input range
or input channef out of range. Analog
output is configurable for either upscale
or downscale burnout. Trip output(s) are
configurable for alarm if sensor failure.



T/C Burnout Current:

T/C, mV, mA, V Failure:

Dielectric Strength:

Insulation Resistance:

Leakage Current:

Long Term Stability:

Warm Up:

Power Consumption:
DC:

120 Vac, 50/60 Hz:
240 Vac, 50/60 Hz:

Agency Approvals:
SC-7400-1 Series

SC-7400-N Series

Less then 0.1 »A

Sensor OK LED turned off with sensor
failure. Failure defined as +5% over or
under the selected input range or input
channel out of range. Analog output
configurable for either upscale or
downscale burnout. Trip output
configurable for alarm if sensor failure.

2.5 kVac 50/60 Hz from input to
output/powet/ground

1500 Vac from power to output/ground
1000 Vac between output and ground
1000 Vac between analog and relay
outputs if applicable

Less than 5 MQ at 500 Vdc after 1
minuie

Less than 1 mA at 2500 Vac after 1
minute

Less than 0.1% of span over 6 months

Full accuracy within 5 minutes of power
applied

Nominal 2.5 W with one transmitier or
trip output {transmitter output at 20 mA
or relay on)

Nominal 3.0 W with two outputs (same
conditions)

Nominal 4 VA at a leading power facior
Nominal 25 VA at a leading power factor

CSA&FM

Inputs Intrinsically Safe

Class |, Division |, Groups A, B, C, & D
Class Il, Division |, Groups E, F, & G
Class I,

Installation - Class I, Division 2, Group
ABC&D

Installation - Class |, Division 2, Group
A B,C&D



Alarm/Trip Output Operation

The following table provides examples of typical refay and LED responses; not all possibilities are
shown. Depending upon how your 3C-7400 is configured, you may see different results.

Input Failure Response: Not Selected
Fallsafe: Not Selected Selected
Burnout Mode: Upscale Downscale Upscale Downscale
Qutput: § Relay LED Relay LED Relay LED Relay LED
Normal State: D e e D i e E e e E e e
AlarmState: | B o | FE o [emeose | D |z | D | o
>5% Over Range: D 200 D o0 E Yot X ) E ore®
>5% Under Range: D ._rr}.. D .{}.. E .ﬁ_.. E .‘I}..
Open Sensor: D o100 D o100 E eiee E eiee®
Processor Failure: D 100 D o0 D ronre D e
Input Failure Response: Selected
Failsafe: Not Selected Selected
Burnout Mode: Upscale Downscale Upscale Pownscale
Qutput: | Relay LED Relay LED Relay LED Relay LED
Normal State: D e e D e e E Hre e E i e
MarmState: | B Joyemmr | B fwoen | P lee | D |
>5% QOver Range: E e 1e E erre D PRCTeY ) D PYereY |
>5% Under Range: E erre £ elte D PYeTey ) D e i@
Open Sensor: E orure E P Feten ) D P¥otoy | D eite
Processor Failure: D 1eee D 11000 D Hete D o0
EY LED Example:
D = De-energized Input  Module Alarm1  Alarm2
E = Energized o3 o4 @ ®
L =LED on on on off off
® = |ED off




Note: Model SC-7404 uses both Alarmi and Alarm2 LEDs; all other models use Alarm1 only. The
ommMndAmmLHkEdwawmuwmmememm@wmmmmm%.Nmemnm
configured independent of Alarm1; see Section 2 or 3 of this manual for configuration information.

Troubleshooting

If you are experiencing difficulties with the $C-7400, check the
following:

1

POWER

INPUT
MODULE
ALARM 1

ALARMZ ||

CONFIGURE —

If the Power LED (green) is OFF:

® Is the module fully seated in the backplane?

® Are the power jumpers set for the appropriate range?

® Is the power supply voltage within the operating
range?

° Contact RiS Technical Support.

if the Power LED and CPU (central processing unit} LED's
are on, but the Input LED is off:

® Is the input within range?
® Is the unit properly configured?
o Contact RiS Technical Support.

If the Power LED is on but the CPU (central processing unit)
LED is off, return the module for repair.

TB3

Figure 12 - LED Locations
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_Section 2 - Hand Held Communicator







Overview

This section provides the basic operating information for the Hand
Held Communicator (HHC/74). The HHC/74 is used with the SC-7400
family of universal transmitters to fransfer data, perform transmitter
configuration, and for inspection and maintenance functions. The
communicator will automatically shut itself off after five minutes of
inactivity to conserve battery power.

Figure 13 - Hand-Held Communicator
(HHC/74)

An alphanumeric display provides an 80 character LCD screen in the

form of 4 lines of 20 characters each. It has a variable contrast control
located on the right side of the communicator. Programs are selected

and initiated from menus.

The HHC/74 has an internal memory device A, and two external
devices B and C which are the equivalent to the disc drives on a
personal computer (See Figure 15). Each one can hold a Rampak,
DataPak or Program Pak. The internal memory (A} of the HHC/74
holds about 31K RAM.

Powered by a 9V battery, the HHC/74 will display a *battery too low”
message when the baitery needs replacement. The message is
displayed for 4 seconds and then the communicator will shut itself off.




Registration

Getting Hel

Before continuing, take a minute to fill out the Registration card and
return it to Rochester Instrument Systems, inc. Returning this card
ensures that you will receive update notices and entitles you to toll-
free customer support. The registration card is located on the last
page of this manual.

Even the most experienced user needs help on occasion. To make
things easier for you, we provide several ways for you to get the
instruction and help you need.

® Read the SC-7400 HHC Communicator Section of
this Manual.

If you have exhausted all other help avenues and need help with your
problem, contact RiS Technical Support at the numbers listed in the
back of this manual.

Support is available Monday through Friday, from 8:15 a.m. to 5 p.m,
Eastern Time.




Kevboard Functions
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Figure 14 - HHC/74 Keyboard

LCD Screen

The HHG/74 alphanumeric display provides an 80 character LCD
screen in the form of 4 lines of 20 characters each (see LCD Screen
above). The HHC/74 has a variable contrast control located on the
right side of the communicator. Programs are selected and initiated
from menus.

Menu selection is accomplished in two ways, either by moving the
cursor with the arrow keys to the desired menu item or by selecting
the first letter of the menu item you desire. If there is more than one
menu item with the same first letter, selecting the letter again will
move you to the next menu item with that first letter. Be sure to look
for the + symbol in the upper right hand corner indicating that there
are additional menu items. Some menus wrap around when you
reach the first or last item.



Letter Kevs

The letter keys normally produce capital {(uppercase) letters on
screen. When typing letters the cursor is a flashing block.

To type lowercase letters hold down SHIFT and press the CAP {1)
key.

To return io capital letters press SHIFT and the CAP (1) again.

Numbers

When typing numbers the cursor is a line.

Hold down SHIFT and press a letter key to type the number or
symbol marked above it.

By holding down SHIFT and pressing NUM (1) the numbers and
symbols keyboard is locked in. Return to letters by holding down
SHIFT and pressing NUM (!} again.

Dedicated Kevs

® ON/Clear Turns the unit ON and is used to back out of a
menu selection.

® EXE Selects menu items and executes functions.

° Arrow Keys  The arrow keys move the cursor Up/Down or
Right/Left on the dispiay screen.

® Dei To delete mistakes, position the cursor with the
arrow keys and use the DEL key. DEL deletes
the character to the left of the cursor. To delete
the character under the cursor hold down
SHIFT and then press DEL.

® MODE This command will toggie you between the
REVIEW mode and EDIT maode.

® OFF To turn the HHC/74 OFF press ON/CLEAR
from the main menu.

Note: If the unit is left on for five minutes without pressing any keys,
it will turn itseif off to conserve battery power. Press ON to
return to the place where you left off.



Initial Setup

There are two ways to use the Hand Held Communicator (HHC/74)

® you can communicate directly with the SC-7400 family
of transmitters
® you can use the PC to communicate with the HHC/74

The second method is useful for transferring previously built or stored
configuration files.

The PC communicates with the HHC/74 via the Psion COMMS Link
software and cabie package. The Psion COMMS Link package is
avaitable as an optional purchase. Refer to the Psion documentation
for installation and operation.

To communicate with the transmitter using the HHC/74 you must:

° Insert the HHC/74 Software Datapak

® Attach the S8C-7411 cable between the SC-7400 and the
HHC/74

® Apply Power to the SC-7400 transmitter

Insert the HHC/74 Program DataPak

Remove the cover from Device B and insert the Datapak. Device B
and C are external devices located on the back of the communicator.
Avoid pressing any key while inserting or removing a Datapak. TIP:
Place the communicator face down on a flat surface.

° To insert a Datapak, push it into the slot until it clicks.
o To remove a Datapak, press down and out on the ribbed
portion.

° Set the Time and Date. Refer to page 2-31.

DEVICEB

B

CONTRAST WHEEL

BATTERY COVER

Figure 15 - Device Band C




Attach the Cable to the Communicator

Attach the SC-7411 Cable to the HHC/74 and the SC-7400 unit. See
Figure 16. The cable attaches to the communicator through a port
located at the top of the HHC/74. Slide the port cover to the right
revealing the port. insert the interface module into the port, pushing
until it clicks. The other end of the cable consists of a keyed probe
that inseris into the front of the SC-7400 transmitter.

SC-7411 POWER
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1
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o
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HHC/74 SC-7400

Figure 16 - Cable Connection of HHC/74 to SC-7400

Apply Power to the SC-7400 Transmitter

Apply power to the SC-7400 unit. Input power is jumper selectable, be
sure to apply the proper power supply. See Section 1 for wiring
diagrams and jumper selections.



Operating Functions

The following instructions are used to configure the RiS SC-7400
family of transmitters.

1 Turn ON the communicator and the transmitter. Allow 10
seconds for the transmitter to stabilize.

2 The communicator may ask for your access code {password).
If prompted, enter your access code and press EXE. The
Main Menu for the SC-7400 transmitter communications will
be displayed.

All the menu screens, iflustrated in this manual, show the full menu
selections. Keep in mind that only four lines of the menu will be
displayed at one time.

The + (plus) sign in the upper right hand corner of the screen
indicates that there are additional menu items. To select these menu
items use the down/up arrow keys or enter the first letter of the
desired item.

Main Menu

The remainder of this section is an explanation of each menu and its
functions. The menus follow the main menu format and are not
necessarily in sequential order. For a step-by-step sequential
example see page 2-45.



Newtx

Newtx establishes communications to the transmitter. Select Newfx
from the HHC/74 Main Menu and press EXE. The communicator will
display the following transmitter information.

Transmitter Data

Press SPACE to continue. The transmitter information will be
uploaded to the HHC/74 and the Main Menu screen will reflect the
Tag Name and the Model # of the transmitter.

........

by oy bt
A —

Main Menu Screen




Info

The Info menu provides a variety of information about the transmitter.
Select Info from the main menu and press EXE. The following
information is displayed:

Model #
Serial #

Tag
Description
Cal. Date
Config. Date

You can change the tag name and the description. The description
field is provided for additional information. Your description can be up
to 20 characters in length. The Configuration Date is automatically
updated with the current date. The Calibration Date and Serial
Number are factory set and can not be changed.

Info Screen

To change the tag name and description:

1

Press MODE to edit the tag name. Press ON to clear the
current name and type in the desired name.

A tag name consists of up to 8 characters. All characters are
vaiid for a tag name, however, filenames must start with a
letter and use only letters and numbers, not symbols. Any
illegal characters in the tag name will be converted to a *Z.
Therefore, you may want your tag names to start with a letter
and avoid illegal characters.

Example: Tag Name: 101:temp
File Name:  zO1ztemp

Select EXE to incorporate the changes.



The description screen allows the user to enter a 20 character
description. To change the description press ON to clear the
current description and type in the desired description. Select
EXE to incorporate the changes. You will be returned to the
Info screen.

Note: If you are operating in the offline mode you have to

choose the model number first before proceeding with
the configuration.

Press ON to return to the Main Menu.



Range

The Range menu displays the current input range selections. This
screen will vary depending upon the transmitter mode! number and
the sensor type. Examples of each input type are explained below.
Remember to select the sensor type before setting the range.

Select Range from the main menu and press EXE. The current range

values will be displayed. To change the range values foliow the
directions below for your particular sensor type.

Millivolt Ranoe

mV Range Screen
To change the range:
1 Press MODE.

2 Enter the Input for Low Output. The operating range is -15.00
fo +85.00 mV. Press EXE.

4 Press ON to return to the Main Menu.



Qhms Range

Ohms Range Screen
To change the range:
1 Press MODE.

2 Enter the Input for Low Output. The operating rahge is
0 to 500 Q. Minimum span is 50 Q. Press EXE.
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3 Enter the Input for Hi Quiput. Press EXE.

4 Press ON to return to the Main Menu.



Thermocouple Range

T/C Range Screen

To change the range:
1 Press MODE.

2 Select the desired temperature scale. Choices are: Celsius,
Fahrenheit, Kelvin, and Rankine. Press EXE.

Note: Range information for Fahrenheit, Rankine and Kelvin is

rounded to the nearest degree C. For example, 930°F
input would be figured as follows:

930°F - 32 x g— 498.89°C

498.82°C is rounded o 499°C and sent to the unit.
The actual number the unit is ranged for in degrees F is
therefore 930.2° F. :

499°C x% + 32 = 930.2°F

930.2° will be displayed on the HHC/74 when displaying
the range information.

3 Enter the Input for Low Output. Press EXE.




4 Enter the Input for Hi Output. Press EXE.
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5 Press ON to return to the Main Menu.
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RTD Range

RTD Range Screen
To change the range:
1 Press MODE.

2 Select the desired temperature scale. Choices are: Celsius,
Fahrenheit, Kelvin, and Rankine. Press EXE.

Note: Range information for Fahrenheit, Rankine and Kelvin
is rounded to the nearest degree C. For example,
930°F input would be figured as follows:

930°F - 32 x §= 498.89°C

498.89°C is rounded o 499°C and sent to the unit.
The actual number the unit is ranged for in degrees F
is therefore 930.2° F.

499°C x% + 32 - 930.2°F

930.2° will be displayed on the HHC when displaying
the range information.

3 Enter the Input for Low Output. Press EXE.




4 Enter the Input for Hi Output. Press EXE.

5 Press ON to return to the Main Menu.

Milliamp Range

Milliamp Range Screen

To change the range:
1 Press MODE.

2 Select the mA Input. Choices are: same, 0-20, 4-20, 0-1, 0-5,
0-10, 0-50 mA. Press EXE.

3 Press ON to return to the Main Menu.




Slidewire Range

Slidewire Range Screen

To change the range:
1 Press MODE.
2 Enter the Slidewire value. Press EXE.

3 Press ON to return to the Main Menu.

Noltage Range

Volt Range Screen
To change the range:
1 Press MODE.

2 Select the Volt input range. Choices are: 0-1, 0-5, 0-10, and
1-5 volis. Press EXE.

3 Press ON to return to the Main Menu.






Sensor

The Sensor menu displays the sensor type, the upper and lower
sensor limits in engineering units, and the minimum span.

Note: If configuring offline, you must specify the model number

before setting up the sensor type.

The internal software will determine if the unit is an IS (intrinsically
safe) or non-1S moedel. The screens will vary slightly for IS models.

Note: After selecting the sensor type, set the Range values.

Select Sensor from the Main Menu and press EXE. To change the
sensor type follow the directions below for your particular sensor .

Millivolt Sensor

1
2

Press MODE to change the sensor type.

Select Millivolt. Press EXE. The following screen will be
displayed.
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Millivolt Sensor Screen

Press ON.
Press SPACE to return to the Main Menu.

Proceed to the Range menu. The operating range is -15.00 to
+85.00 mV. Zero and span may be set anywhere within this
range. The minimum span is 4 mV.



Ohms Sensor

1 Press MODE to change the sensor type.
2 Select Ohms.

3 Choose the resistance measure; three wire or four wire.
Press EXE.

Ohms Sensor Screen

4 Press ON.
5 Press SPACE to return to the Main Menu.

6 Proceed to the Range menu. The operating range is 0 1o
500 Q. The zero and span can be set anywhere within the
range. Minimum span is 50 Q.



Thermocouple Sensor

1 Press MODE to change the sensor type.

T/C Sensor Screen

2 Select the thermocouple type. Press EXE.

3 Select the linearization type; same, millivolt or temperature.
Press EXE.
4 Press ON.

5 Press SPACE io return io the Main Menu.

6 Proceed to the Range menu.



RTD Sensor

1 Press MODE to change the sensor type.

RTD Sensor Screen

2 Select RTD from the menu. Press EXE.

3 Select the RTD sensor type: PT100, Ni120, or Cui0. Press
EXE.

4 Each sensor type requires a sfightly different action.
° For the PT100 RTD select the alpha number: 385,
3916, or 3923. Press EXE. Choose the RTD measure -
two wire, three wire, or four wire differential. Press
EXE.

) For the Ni 120 RTD select the RTD measure - two
wire, three wire, or four wire differential. Press EXE.

® For the Cu10 RTD you do not have to select anything.
5 Press ON.
6 Press SPACE to return to the Main Menu.

7 Proceed to the Range menu.



Milliamp Sensor

1

2

Slidewire Sensor
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~voltage Sensor

1
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Press MODE to change the sensor type.
Select milliamp. Press EXE.

Press ON.

Press SPACE to return to the Main Menu.

Proceed to the Range menu.

Press MODE to change the sensor type.
Select slidewire. Press EXE.

Press ON.

Press SPACE to return to the Main Menu.

Proceed to the Range menu.

Press MODE to change the sensor type.
Select volt. Press EXE.

Press ON.

Press SPACE to return to the Main Menu.

Proceed to the Range menu.






Qutput

The output(s) are programmed depending upon the model number
(refer to list below).

Model Number Output Type

SC-7401-N Single analog output

SC-7401- | Single analog output, intrinsically safe input
SC-7402-N Dual analog output

SC-7402-1 Dual analog output, intrinsically safe input
SC-7402-N-100 Dual analog output, 0-100 mV fixed input
SC-7403-N Single trip/alarm output

SC-7403-1 Single trip/alarm output, intrinsically safe input
SC-7404-N Dual trip/alarm output

SC-7404-1 Dual trip/alarm output, intrinsically safe input
'SC-7405-N Single analog and single trip/alarm output
SC-7405-1 Single analog and single trip/alarm output,

intrinsically safe input
A description of each mode! and its output(s) is described below.
Select Output from the Main Menu. Press EXE. The current output

values will be displayed. To change the output values foliow the
directions below for the proper transmitter type.

Analog Qutput (SC-7401)

Analog Output Screen

1 Press MODE.

2 Select the analog output range. Range choices are 0-1 mA,
0-5 mA, 0-10 mA, 0-20 mA, 4-20 mA, 0-1 V, 0-5V, 1-5 V, and
0-10 V. Press EXE.



3 Select the Burnout, either Upscale or Downscale. Press EXE.
4 Press SPACE.

5 Press ON to return to the Main Menu.

Two Analog QOutputs (SC-7402)

Both outputs are identical for the dual analog output transmitter (SC-
7402), therefore you only have 1o determine the output values once.

e
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Dual Analog Output Screen

1 Press MODE.

2 Select the analog output range. Range choices are 0-1 mA,
0-5 mA, 0-10 mA, 0-20 mA, 4-20 mA, 0-1V, 0-5V, 1-5V, and
0-10 V. Press EXE.

3 Select the Burnout, either Upscale or Downscale. Press EXE.

4 Press SPACE.

5 Press ON to return to the Main Menu.



Digital Qutput (SC-7403)
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Digital QOutput Screen

Press MODE.

Select Yes or No, for Failsafe Operation. Press EXE.

Select Alarm or Hold, for the Response to Input Failure.

Press EXE. :

Enter the Trip Delay in seconds. Press EXE.

Select High or Low, for the Trip Setting. Press EXE.
Enter Trip Level in percent of span. Press EXE.
Enter the Deadband in percent of span. Press EXE.
Press SPACE.

Press ON to return to the Main Menu.



I'wo Digital Qutputs (SC-7404)
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Digital Output Screen

Press MODE.
Select Same, Yes or No, for Failsafe Operation. Press EXE.

Select Same, Alarm or Hold, for the Response to Input
Failure. Press EXE.

Enter the Trip Delay in seconds. Press EXE.
Select the Trip Setting, Same, High or Low. Press EXE.
Enter the Trip Level in percent of span. Press EXE.

Enter the Deadband in percent of span. Press EXE. Qutput
Channel 1 is configured.

To configure Output Channel 2, press SPACE.
Select, Same, Yes or No, for Failsafe Operation. Press EXE.

Select, Same, Alarm or Hold, for the Response to Input
Failure. Press EXE.

Enter the Trip Delay in seconds. Press EXE.

Select the Trip Setting, Same, High or Low. Press EXE.
Enter the Trip Level in percent of span. Press EXE.
Enter the Deadband in percent of span. Press EXE.
Press SPACE.

Press ON io return to the Main Menu.



One Analeg, One Digital Qutput (SC-7403)

..........

T

Analog & Digital Output Screen

1 Press MODE.

2 Select the analog output range. Range choices are Same, 0-1
mA, 0-5 mA, 0-10 mA, 0-20 mA, 4-20 mA, 0-1 V, 0-5V, 1-5 V,
and 0-10 V. Press EXE.

3 Select the Burnout, either Same, Upscale or Downscale.
Press EXE. Output Channel 1 is configured

4 To configure Output Channel 2, press SPACE.

5 Select Failsafe Operation. Same, Yes or No. Press EXE.
6 Select the Response to Input Failure, Alarm or Hold. Press
EXE.

7 Enter the Trip Delay in seconds. Press EXE.
8 Select Trip Setting, High or Low. Press EXE.
9 Enter Trip Level in percent of span. Press EXE.

10 Enter the Deadband in percent of span. Press EXE. Output
Channel 2 is configured.

11 Press SPACE.

12 Press ON to return to the Main Menu.






The Tools menu provides access to the following functions: Time,
World Files, and COMMS Link.

Time

Tools Screen

Time and Date

1 Select Time from the Tools menu.

2 Press MODE to get the menu:
Stopwatch Timer Set -

3 Select SET and press EXE. Change the time and date using
the arrow keys.

4 Press EXE.

5 Select ON/Clear to return to the Tools Menu.

Note: When you change the battery, you need to reset the time and
date.

Stopwatch

1 Select Time from the Tools menu.

2 Press MODE to get the menu:
Stopwatch Timer Set -

3 Select Stopwatch from the Time menu:

STOPWATCH
00:00:00.00



It records in increments of 0.05 seconds. To start the stopwaich,
press EXE. Then use the following keys:

® SPACE whenever you want to record a laptime.

° DEL to freeze the display, the flashing dot shows the
stopwaich is still counting. Press DEL to reset it.

e EXE to stop it then DEL to reset it

Return to the ordinary clock again with ON/Clear.

Timer
1 Select Timer on the Time menu:
TIMER
Mins: 00 Secs:00
2 The cursor is on the minutes, ready for you 1o set the time you

want to count down from.

Use - to move between the minutes and seconds and
1 and | to change the settings.

Press EXE to start the count down. (ON/Clear
cancels).

When it gets to zero, the alarm sounds for one minute.

Press ON/Clear to swiich it off.



Worid

World allows you to set your home location. You can then find out the
dialing code from there to any major city in the world. It also provides
the time in these cities. The home location is the one displayed on the
clock when you select time from the Tools menu. Whenever you reset
the home location, the time changes on the clock to reflect the
different time zone.

To reset the location:

1 Select World from the Tools menu. The first time, you are
shown a screen showing you how to dial New York from the
current home location. On this screen you can use | and 1 to
browse through the list of cities and countries.

New York Manhattan
USA
Sun 1Jan 9:00a
Dial: 0101 212

2 To set your location:
® Press MODE to get the SET FIND menu:

° Press EXE to Set and this prompt appears at the
bottom of the screen:

Set Home: _

. Start typing in the name of your nearest major city. As
500N as you start typing, a city or country is displayed.
If it is not the correct city, use | fo scroll through the

list of alternatives and 1 to come back up again, or
type a few more letters of the name..

3 When the city you want is displayed, press EXE.

4 Press ON/Clear to return to the Main Menu.



Finding out codes and times

You can now use FIND to look up the dialing code from your location
to any major city in the world. You are also told the current time in
that city.

® There is no need fo get the menu, just start typing the first few
letters of the city you are phoning:

The Find prompt appears, and a matching city and country are
displayed.

® Press EXE if the city is the one you want. If it is not, use the |
to scroll through the list of cities and press EXE on the right
one, or type a few more letters.

If you wani to see all 650 cities and countries, you can type A then
use ! to scroll down.

Files

This function can be used to find and manipulate files created by
Upload. A data file is a collection of records. When you save a file
using the Upload option from the main menu, the record goes into a
data file called MAIN. This is also where the Find option looks for
records.

s Select Fifes from the Tools menu.
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File Options
Find

Save

New

Open

Print

Finds a record with a search clue - looking in the
current data file.

Saves a record in the current file. After each save you
return to the Save prompt - useful for saving a lot of
records a once.

Use EXE to save a file. After you have saved a record
you are given the chance to save another record,
instead of just returning to the menu. This is useful
when you want to save a lot of records.

Creates a new data file and auiomatically makes this
new file the current one.

Press MODE to select the device you want the new
data file to be on.

Type in the name you want for it.

File names can be up to eight characters long. The
first character must be a letter.

Opens a data file, making that file the current file
which is then used by Find and Save.

You are prompted for the file name to open:

Open A: _

Press MODE if you need to select another pack, then
type the name of the data file you want to make
current.

To see a list of files press | and choose ihe file you
want by pressing EXE.

Prints the whole current data file, or selected records
from it.

Select Print and press EXE to print all the records, or
enter a search clue to print only the matching records.

You can press ON/CLEAR at any time to stop
printing.

If there is no printer attached, you will get a DEVICE
MISSING message.



Sort

Dir

Sorts the records in the data file into alphabetical
order.

Press EXE to sort the records.

WARNING! DO NOT SORT TRANSMITTER
DATA RECORDS!

Sorting requires a lot of memory. You need
approximately twice the amount of space as the size
to the data file being sorted. If there isn't enough
space, the error message OUT OF MEMORY is
displayed.

Displays a directory of all the data files on the device
you select.

When you select DIR the following screen appears.

Dir of Files
Dir A_

Press EXE or | 1o see the list of files, then | and 1 to
browse through them.



Copy

Delete

Copies one or more data files.

When you select Copy the following screen appears:

Copy Files
From A: _

Press MODE if the file is to be copied on a Datapak.

To copy just one fite that you know the name of, type
the name and press EXE.

To see a list of files to choose from, press EXE, move
down through the list with : and press EXE on the file
youwant. To copy all the files in the list, select <*>.
You will then see this prompt:

ToB: _

Press MODE if you are copying to a different pack
from the one suggested.

If you are copying only one file, and you want the copy
to have a different name, type it. If you want the copy
to have the same name, don't type anything.

Press EXE.

Deletes one or more data files.

When you select Delete you will be prompted:

Delete A: _

Press MODE if the file is on a pack.

To see a list of files to choose from, press EXE, move

down through the list with | and press EXE on the file
you want. To delete all the files in the list, select <*>.



COMMS Link

This feature is used with the optional Psion COMMS Link Software,
which allows communication between the HHC and a PC. The
COMMS Link menu determines whether to send or receive
information io the PC.

Upon selecting Send or Receive you will be given a list of files to
select from.

Select the file name and press EXE. A message will be displayed
acknowledging the action.

If you choose an existing filename (at the destination); the HHC/74
will display a waming message. You can then select to abort or
overwrite the file.



Upload

Download

Upload saves the transmitter parameters to a file on the A: drive of
the communicator. When creating a file the communicator uses the
Tag Name as the filename. A tag name consists of up to 8
characters. All characters are valid for a tag name, however,
filenames must start with a letter and use only letters and numbers,
not symbols. Any illegal characters in the tag name will be converted
to a “Z*. Therefore, you may want your tag names to start with a letter
and avoid illegal characters.

Example: Tag Name: 101:temp
File Name: z01ztemp

The uploaded file can now be modified and downloaded to the
iransmitter(s). Files are saved to Drive A.

Note: Drive A is volatile memory. Changing the batteries could resuft
in loss of data. To save data, transfer the file(s} to an optional
rampak or datapak on Drive G, or use the Psion COMMS Link
to a PC.

Download transfers a file from the communicator to a transmitter.
Select Download and follow the prompts. This procedure will
overwrite the existing transmitter memory.






Password

Each person using the communicator can have a unique password.
The HHC/74 Main Menu will differ slightly with each level of access.

Password Screen

The password levels are: Password, Configure, and Monitor.

Password allows the user to perform all functions.

Configure allows the user to perform alf functions with the
exception of passwords.

Monitor allows the user o view all functions only.

Once you have entered a password level password, you can choose
to set password protection ON or OFF. If password protection is on,

the password will be requested every time the machine is turned on.
The Password protection feature is turned on and off with the Enable
function.

To Add a Password:

1

Note:

Select Password from the HHC/74 Main Menu. The
Password menu will be displayed.

Select ADD from the menu. Passwords can be up to 19
characters long. Press EXE.

Re-enter the password and press EXE.

Select the Access Level: Password, Configure or Monitor.
Follow the prompts.

The first password entered will automatically have an access
level of password.



To Remove a Password:

1

To remove a password, select Password from the HHG/74
main menu.

Select Remove from the password menu.

You are prompted to enter the password. Upon pressing EXE
you will be prompted to re-enter the password.

To Change the Access Level of a Password:

1

To change the access level of the password, select Password
from the HHC/74 main menu.

Select Change from the password menu. Enter the existing
password. You will be prompted to re-enter the password
again.

Choose the access level desired: Password, Configure, or
Monitor and follow the prompts.

To Show the Access Level of a Password:

1

To show the access level of a password, select Password
from the HHC/74 main menu.

Select Show from the password menu. Enter the existing
password. You will be prompted to re-enter the password
again. The access level will be displayed.

To Enable the Password function:

1

To enable a user to enter a password, select Password
from the HHC/74 main menu.

Select Enable from the password menu. Follow the
prompis.



To Disable the Password function:

1 To disable the access level of all passwords, select
Password from the HHC/74 main menu.

2 Select Disable from the password menu. Follow the
prompts.

CAUTION: [f the unit shuts off after 5 minutes pressing ON wil
return you to the place where you left off. This also
allows someone else access to your communicator.
For security reasons be sure 1o turn your
communicator OFF.
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Examples

Example 1:

Step 1:
Step 2:

Step 3:

Step 4:

Step 5:
Step 6:
Step 7:
Step 8:
Step 9:
Step 10:
Step 11:

Step 12:

Step 13:

Step 14:

Step 15:

Change the input type, range, and the output range for an existing
SC-7401. The SC-7401 (single analog output) is presently configured
for a type K thermocouple input with a range of 0 to 200 °C, linear to
temperature, and an output of 0 to 10 mA, upscale burnout. Change
the input to a type J thermocouple with a range of 0 to 500 °C, linear
to temperature, and the ouiput to 4 to 20 mA, upscale burnout.

Connect the HHC/74 to the unit.
Press ON (to turn on the HHC/74).

When the main menu appears select Newtx (to load unit
configuration data into the HHC/74).

When the TAG NAME screen appears press SPACE to continue.

When the main menu appears select Sensor (io change the sensor
type).

When the SENSOR screen appears press MODE (to enter the edit
state).

When the Choose sensor type menu appears select T/C (to choose
thermocouple}.

When the Choose T/C type menu appears select J {to choose J type
T/C).

When the Choose Linearization Type menu appears select Temp (1o
choose linear to temperature).

‘When the SENSOR screen appears press ON (to return to the main

menu}.

A message will be displayed stating that the sensor type has been
changed, proceed to Range. Press SPACE (to continue).

When the main menu appears select Range.

When the RANGE screen appears press MODE (to enter the edit
state).

When the PV/Range Units menu appears select Celsius.

When prompted to enter the low range press ON (io clear the
displayed value}.



Step 16:

Step 17:

Step 18:

Step 19:

Step 20:

Step 21:

Step 22:
Step 23:

Step 24:

Step 25:

Example 2:

Step 1:

Step 2:

Step 3:

Step 4:

Step 5:

Step 6:

Enter 0. Press EXE (io enter the value).

When prompted to enter the high range press ON (io clear the
displayed value).

Enter 500. Press EXE (o enter the value).

When the RANGE screen appears press ON (to return to the main
menu).

When the main menu appears select Output.

When the OUTPUT screen appears press MODE (io enter the edit
state).

When the Select Analog QOutput menu appears select 4 - 20 mA.
When the Select Burnout menu appears select Upscale.

When the QUTPUT screen appears press ON (to return o the main
menu).

When the main menu appears select ON to turn off the HHC/74.

Modify a configuration file offfine for a SC-7405 and then download
that file to a unit installed in the field. The file is saved under the Tag
PWS001 (the units Tag number, this will have to be done 1o try this
example). Change analog output burnout from upscale to downscale
and the trip output level from 65% to 66.7%. Change the trip output
delay from 0 to 2 seconds. Leave other parameters the same. The
sensor type and range will not change.

Press ON (to turn on the HHC/74).

When the main menu appears seiect Download (to load the unit
configuration data into the HHC/74).

When prompted to connect o a transmitter, press N (there is no
transmitter connected yet).

When the TAG TO DOWNLOAD screen appears enter PWS001.

When the "File downloaded to communicator memory” message is
displayed press SPACE (to continue).

When the main menu appears select Output.



Step 7:

Siep 8:

Step 9:

Step 10:

Step 11:

Step 12:

Step 13:

Step 14:

Step 15:
Step 16:

Step 17:

Step 18:
Step 19:

Step 20:

Step 21:

Step 22:

Step 23:

Step 24:

Step 25:

Step 26:

When the OUTPUT screen appears, press MODE (io enter the edit
state).

When prompted to connect to a fransmitter, press N (there is no
transmitter connected yet).

When the Select Analog Output menu appears select Same.
Press EXE.

When the Select Burnout menu appears select Downscale.

When the "Channel 1 configured Beginning Channel 2" message is
displayed press SPACE (to continue).

When the Failsafe Operation menu appears select Same. Press EXE.

When the Response to Input Fail menu appears select Same.
Press EXE.

When the Enter Trip Delay screen appears select ON to clear the
displayed value.

Enter 2 for a 2 second delay. Press EXE.
When the Select Trip Setting menu appears select Same. Press EXE.

When the Enter Trip Level screen appears select ON to clear the
displayed value.

Enter 66.7 for a trip level of 86.7% of span. Press EXE.
When the Enter Deadband screen appears press EXE.

When the "Output Channel 2 configured” message is displayed press
SPACE (to continue).

When the OUTPUT screen appears press ON (to return to the main
menu.

When the main menu appears select Upload (to save the new
configuration data into the HHC/74).

When the "WARNING: FIlLE EXISTS" message is displayed select
Overwrite.

When the "Uploaded to: A:PWS001" message is displayed press
SPACE to continue.

When the main menu appears select ON to turn off the HHC/74.

Take the HHC/74 to the unit in the field.



Step 27:

Step 28:
Step 29:
Step 30:

Step 31:

Step 32:

Step 33:

Step 34:

Connect the unit fo the SC-7405 to be reconfigured with the SC-7411
cable provided.

Press ON key (to turn on the HHC/74).
When the main menu appears select Download.
When prompted to connect to a transmitter press Y.

When the TAG NAME PWS001 screen appears press SPACE 1o
continue.

When the TAG TO DOWNLOAD screen appears enter PWS001.
Press EXE to send to the unit.

When the "File downloaded to transmitter” message is displayed
press SPACE (to continue).

Press ON (to tumn off the HHC/74).



Maintenance Procedures

Batterv Replacement

The HHC/74 uses one 9 volt PP3 battery. Alkaline batteries are
recommended 1o avoid data loss. If you are a heavy user, you can
expect to replace the battery about every 3 months. The message
“Battery too Low” will be displayed for 4 seconds and then the unit will
switch itself off. You should replace the battery as soon as possible.

® Do nof switch the unit ON again until you have replaced the
battery.

® Do not remove the battery until you have a new one ready.

° Data on Datapaks and Rampaks are permanent and do not

rely on the battery.

® Data on Device A depends on the battery and may be lost.

Figure 17 - Battery Compartment

The battery compartment is located at the base of the unit. Refer to
Figure 17.

To replace the battery:
® Turn the unit OFF.

® Remove the battery cover by gripping the case firmly and
pulling downward until the cover snaps off.



Connect the new 9V battery and slide it into the battery
compartment with the positive (+) contact going in first. Make
sure that the contacts on the top of the battery slide all the
way into the connector. Refer to Figure 17.

Replace the battery cover by placing the lip into the
corresponding groove. Clip the tab in place.

Re-instate HHC/74 Software Program by selecting MODE.
You will be prompted to insert menu item. Type in HHC/74
and press EXE. This will install the HHC/74 menu item. Press
EXE again to enter the HHC/74 program menu.

Set the Time and Date (see page 2-31).



Troubleshootin

The following is a guide for solving basic problems with the hand held

communicator.

Blank Screen

Missing Item on Main Menu

Out of Memory

Battery Too Low

Keypress Beeps

Stuck in an OPL Program

Question mark ? on Screen

Adjust the contrast wheel on the
right side of the case.

The item probably was deleted by
mistake.

This message indicates a lack of
internal memory. Memory should
be freed up by deleting unwanted
records or procedures.

This message indicates that the
battery is about to run out and after
4 seconds the HHC/74 will turn
itself off. Replace the battery before
turning on again.

If while typing, the keystrokes are
ignored and the unit starts beeping
there are too many characters
being entered. The limit is 64
characters in a diary eniry and 254
characters with a maximum of 16
lines in a database record.

It is usually possible to break out of
running a OPL program by pressing
ON\CLEAR followed by a Q.
However, if an OPL program has
a loop in it which reads keys with a
command such as GET< KEY or
INPUT, it may be very hard to
break out in this way. Try pressing
ON/CLEAR followed by Q
repeatedly in rapid succession.

If a ? appears on the screen, an
OPL program is using the INPUT
command and inappropriate data
has been entered. For example
text, when numerals were required.
Try again with the right kind of data.
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_ Section 3 - PC Configurator







Overview

Svystem Requirements

The family of SC-7400 Universal 4-wire Transmitter/Alarms are
configured using either the SC-7400 PC Configurator program or the
HHC-74 (Hand Held Communicator). The PC Configurator program
communicates directly with the SC-7400 transmitter to upload, download
and configure the unit.

The SC-7400 PC Configurator can also be used to communicate with
the HHC/74 (Hand Held Communicator) via the Psion COMMS Link
software and cable package. The Psion COMMS Link package is
available as an optional purchase. Refer o the Psion documentiation for
instaliation and operation.

This section will provide you with all the information you need to start
using the SC-7400 PC Configurator. You will learn how to:

Instali SC-7400 PC Configurator on your hard disk.
Register your copy of SC-7400 PC Configurator.

Get help with SC-7400 PC Configurator.

Perform the Cable Hookup

Use the SC-7400 PC Configurator software program.

Before you install the program, make sure you have all the hardware and
software you need to run SC-7400 PC Configurator:

® IBM® compatible computer with a 386 (or higher)
processor and a minimum of 4MB memory, running at
25 Mhz or higher

VGA or EGA monitor

2 MB minimum of free disk space on the hard drive.

3% (1.44M) floppy disk drive

RS232 serial port with a 25 pin connector. A 9 to 25 pin
adaptor can be used if you have a 9 pin RS232 serial port
Microsoft DOS® 3.3 or higher

Windows® 3.1 or higher

L SC-7410 Cable

Optional Accessories

® Microsoft® mouse or equivalent
® Psion COMMS Link Package



Installation

The installation of the SC-7400 PC Configurator software will not
impact the operation of any previously installed RiS software or
equipment. The SC-7400 PC Configurator software is Windows
based software; if you are unfamiliar with using menus, dialog boxes,
scroll bars, or the control-menu box, spend some time reading your
Windows documentation.

To install SC-7400 PC Configurator

1
2

Change the drive to the desired destination.

Make a directory called SC7400.
Example: C:>md sc7400
Change the drive to the source directory.

Example: Drive A>> or B>

Start the instal! program by typing install and the destination
location.

Example: Ax>install C:\sc7400

Once you finish copying the program to your hard drive, make a
backup copy of the disks. Put the original disks away in a safe place.
Avoid exposing them to sunlight, dust, and magnetic fields.

5
6

Start Windows.

Choose New from the File menu. The following screen will be
displayed.

=| Wew Program Object

Hew
o Program Group
@® Program ltem;




7 Select Program ltem and press OK. The following screen will
be displayed.

Prograw ltem Properties

Description: N l i ax g

= d Line: Cancel g

Co
Working Directoiy:
S

horicut Key: |None | .

fehange Ioon..,

[T Run Minimized

8 Enter the following information:
Description: SC-7400
Command Line: Cwindows\sc7400\sc7400.exe

Working Direciory:  C:iwindows\sc7400

9 Select OK. Upon selecting OK, Windows will create an icon
and place it in your application group.

10 Select the program icon to start the application. If you do not
have a mouse, refer to Appendix A for keyboard operation.

SC-1400
SC-7400
Icon

Quitting SC-7400 PC Configurator

To quit SC-7400 PC Configurator,

1 Choose Exit from the File menu.

Registration

Before continuing, take a minute o fill out the Registration card and
return it to Rochester Instrument Systems, Inc. Returning this card
ensures that you will receive update notices and entitles you to toll-
free customer support. The registration card is located on the last
page of the manual.



Getting Help

Even the most experienced user needs help on occasion. To make
things easier for you, we provide several ways for you to get the
instruction and help you need.

Read the SC-7400 PC Configurator Manual.
Use the On-Line Help.

Refer to the Windows Manual

Refer to the DOS Manual

If you have exhausted all other help avenues and need help with your
problem, contact RiS Technical Support at the numbers in the rear
of this manual.

Support is available Monday through Friday, from 8:15 a.m. 1o 5 p.m,
Eastern Time.



Cable Hookup

To communicate with the 8C-7400 fransmitter you must:
® attach the SC-7410 Cable to the transmitier and the PC

® apply power to the transmitter

1 Connect the SC-7410 Cable to your computer and the
SC-7400 unit. Attach the 25-pin RS232 connector to your
COM port connector. If you have a 9-pin connector you can
use a 9 to 25-pin adaptor (not supplied). Insert the keyed
probe into the front of the SC-7400 unit.

POWER

TB1

— TB2

o POWER

Q INPUT

o MODULE
=} ALARM 1
[} ALARM2

A SC-7410

i y CONFIGURE

=l R8-232 PORT

)\

— TB3

Figure 18 - PC to SC-7400

2 Supply power to the SC-7400 unit.
Note: The power supply is jumper selectable. Make sure you

apply the appropriate power to the unit. See Section 1
for wiring diagrams and jumper selections.

3 Type win, at the DOS prompt, to start Windows.
4  Select the SC-7400icon from the Windows programs group.

S5C-T400




To communicate directly with the transmitter; select the proper
COM port from the drop-down box and select OK. The current
transmitter configuration values will be uploaded.

To build files offline select Stand Alone. Stand Alone aliows
you configure information for storage as a file. If you are using
the Stand Alone method, the transmitter values are defauiied
to:

Input = 0 to 85 mV

Output = 4 to 20 mA for analog outpuis

Output = 50 % Hi trip, no delay. 1% deadband, non-failsafe
for trip outputs

Power = 20-138 Vdc

=| Com Port Selection

Exit |

I StandAlone

. Help 3




Configuring the Input Values

This section describes the process for selecting the desired input

value.
1 Select Inputs from the Configuration menu. The following
screen will be displayed.
Input Configuration
) Ohms
O RTD
 Millivolt  Shdewire
{7} Thermocouple
2 Select the Input Type, the choices are: Voltage, Current,
Millivolt, Thermocouple, Ohms, RTD, and Slidewire.
Note: Voltage, Current, and Slidewire are not included for IS
models. The software will determine if the unit is an IS
(intrinsically safe) or Non-IS (non-intrinsically safe)
model.
3 Select Setup and follow the directions below for each tnput
Type. :
Voltage Input
1 Upon selecting Voltage, the following screen will be displayed.
=| | Yoltage Inputs
1] 4
Input Range: =

Cancel
Help §

2 Select the Input Range value from the drop-down box by
highlighting your choice and selecting OK. Upon selecting OK,
you will be returned to the main screen.



Current Input

1 Upon selecting Current, the following screen will be displayed.

=f Current Inputs

Input Ranne:

2 Select the input current value from the drop-down box by
highlighting your choice and selecting OK. Upon selecting OK,
you will be returned to the main screen.

Millivolt Input

1 Upon selecting Millivolt, the following screen will be
displayed.
= Millivelt inputs

!'anut Range

2 Set the Input Range and select OK. You may type in the value
or use the incremental arrows fo select the desired value. The
default ranges shown are the minimum and maximum values.
Upon selecting OK, you will be returned to the main screen.



Thermocouple Input

1 Upon selecting Thermocouple, the following screen will be
displayed.

Choose whether you want the display units to be degrees
Centigrade or Fahrenheit, and click on OK to proceed to the next
screen. This example will use Centigrade.

=| Thermocouple Inputs

[ Input Type
DIN:

Q Tepe d
3 Type T
B5:

O Type H

1 Linear Dutput
" Input Range

180 [Sic o [780 [Sc

2 Select the desired Thermocouple Input Type. The input range
selections will change dependant upon the thermocouple type.
You may type in the input range or use the incremental arrows to
select the desired value. The input ranges shown are the default
minimum and maximum input values.

3 Select the Input Range.

4 If you desire Linear Output, check the linear output box. Linear
output wiil provide you with an output proportional to temperature.

5 Select OK. Upon selecting OK, you will be returned o the main
screen.



Qhms Input

1 Upon selecting Ohmes, the following screen will be displayed.
=] Ohm Inputs
Input Hange
|: E  [Eoms 1w 500 [+ Ohms Lec ]
Wires
® 3 Wites
lr'o 4 Wites
2 Set the Input Range. You may type in the input value or use

the incremental arrows to select the desired value. The input
range values shown are the default minimum and maximum

values,

3 Select 3 or 4 wires.

4 Select OK. Upon selecting OK you will be returned to the main
screen.



RTD Input
1

Upon selecting RTD, the following screen will be displayed.

Choose whether you want the display units to be degrees
Centigrade or Fahrenheit, and click on OK to proceed to the next
screen. This example will use Centigrade.

=| ETD Configuration
T wire Type
OF 3850;
O P 916
{3 Platinum - .3923
) Mickel
) Coppex
Wire Configuration
O 7 e
® 3 Wite
O 4 wite

£ 3 Wite Differential

[ Input Range

e I

Select the Wire Type.
Select the Wire Configuration.

Set the Input Range. You may type in the input range value or use
the incremental arrows to select the desired value. The input
range values shown are the default minimum and maximum
values.

Select OK. Upon selecting OK, you will be returned to the main
screen. '



Slidewire Input

1 Upon selecting Slidewire, the following screen will be
displayed.
=-| Slidewire Inputs
Input Range 0K
lr DOhms to Nhms s

2 Set the Input Range. You may type in the input range or use
the incremental arrows to select the desired value. The range
values shown are the default minimum and maximum values.

3 Select OK. Upon séiecting OK, you will be returned to the
main screen.

J-12



Configuring the Qutput Values

The output screens are dependent upon the SC-7400 model number.
There are two screens; the Analog Output screen and the Relay
Qutput screen. You may see one or both of these screens dependent
upon the model number.

The following is a list of the available SC-7400 models. The N after
the model number denotes non-intrinsically safe and the | indicates

intrinsically safe.

SC-7401-N
SC-7401-1

SC-7402-N
SC-7402-1
SC-7402-N

SC-7403-N
SC-7403-1

SC-7404-N
SC-7404-1

SC-7405-N
SC-7405-1

Single analog output
Single analog output, intrinsically safe input

Dual analog output
Dual analog output, intrinsically safe input
Dual analog output, 0-100 mV fixed input

Single trip/alarm output
Single trip/alarm output, intrinsically safe input

Dual trip/alarm output
Dual trip/alarm output, intrinsically safe input

Single analog and single trip/alarm
Single analog and single trip/alarm, intrinsically
safe input
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Analog Output Screen

The analog output screen is displayed for the SC-7401, SC-7402, and
SC-7405. Both outputs for the SC-7402 dual analog output unit are
the same, therefore the analog output screen applies for both outputs.
The SC-7405 has both an analog and a relay output screen; therefore
once you configure the analog output the relay output screen will be
displayed.

= Anafeg Oulput Configuration

Input Failure
| @® Upscale

Analog Dutput Bange:

O Downzcale

1 Chose Qutputs from the Configuration menu.
Select the Analog Output Range from the list box.

Select the Input Failure, either Upscale or Downscale.

B W N

Select OK. Upon selecting OK, you will be returned to the
main screen.



Relav Qutput Screen

The Relay Output Screen is displayed for the SC-7403, SC-7404 and
the 5C-7405. The SC-7404 screen is slightly different in that it
prompts you to select outputs for both channels.

~N O O

=| Relay Qufput Configuration
Phounel Selovkion
& fine
O fwn
Deadband: Trip setling
| OK g
ZolSpan | @ High —
Trip Delay: O Low
[2] 5econds
Failsafe
Tsip Level O i
# Fg Input Failure Response

Choose Outputs from the Configuration menu. You may
type in the desired values or use the incremental arrows to
select the value.

Set the Deadband value. The deadband value is the range of
values for which the applied control quantity (voltage or
current) has no effect on the response of the circuit; therefore
the deadband is the percent of span before the alarm will
reset.

Select the Trip Delay. The trip delay determines how long the
output has to remain at the trip level before activating the
alarm.

Set the Trip Level. The level at which the alarm will activate.
Select the Trip Setting, High or Low.

Select Failsafe if desired. Relay will tum off on alarm.

Select Input Failure Response if desired. Input Failure
Response causes the alarm to activate when the sensor fails
or is out of range.

Select OK. Upon selecting OK, you will be returned to the
main screen.






Saving Files

When you create a configuration, it is not permanently stored until
you save it as a file. A new file can be created by modifying an
existing file, or by creating a new file.

To create a new file;

1 Select New from the File menu. The new file will contain the
default values.

2 Modify the configuration.

To save a new file;

1 Choose Save from the File menu. The following screen will be
displayed.
'*—“'| Save As
File Hame: Directones:
c-\windowshgystem "
gsiviE ss; le] = D:’f P2 luose Cancel
e 2 windovs
2 g
Save File as Type: Brives:
Config Files [*.sc7)] |§ | =l c: minos @
2 Specify the drive and directory where you want the file stored.
3 Type a filename in the File Name text box.
4 Select OK to save the file and return to the configuration
program.

To modify an existing file;

1 Access the existing file by selecting Open from the File menu.
2 Select the appropriate file.

3 Select OK.

4 Modify the configuration.
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Select Save from the File menu to save the modified file
under the same name

OR

Select Save As from the File menu 1o save the modified file
under a different filename.



Upload Configuration

Upload allows you to upload the current configuration into the SC-
7400 PC Configuration program. You can then manipulate the
information as necessary.

1 Chose Communications Upload from the Communications
menu. The following screen will be displayed.

=| Communication Upload

Retiieve from
Pert Selection:

Cancel

2 Chose the Port to retrieve the information.
3 Select Upload. The computer will upload the current
configuration.

Note: Be sure to close all open files or save the current configuration
as a file as the Upload function will replace all values with the
transmitter values.



Download Configuration

Download sends the configuration information to the SC-7400 unit.

1

Chose Communication Download from the
Communications menu. If you have invoked a password, you
will be prompted for it at this time. Enter the password and
select OK. If you have not assigned a password you will not
be prompied. The following screen will be displayed.

==| Communication Download
& end to Download
Port Selection: Cancel

- Help
| Yiew E

Select the appropriate COM port from the drop-down box.

Select View to preview your configuration selections. This
feature allows you to look at the selected setlings before
downloading them to the unit. There are two screens, one
showing the input configuration and the other showing the
output configuration. You can not make changes from these
screens. To make changes, select Cancel and reconfigure the
inputs and/or outputs as desired.

Select Download. The input and output configurations will
now be sent to the unit.



The Print function allow you to print out the configuration file.
Choosing View from the File menu allows you to preview the current

configuration. The input selections are displayed first; the output
configuration is second.

1 Choose Print from the File Menu. The following screen will
be displayed.

=il Print

Fanter ail?;j\zz::t?eﬁ{/n?nﬁms {LFTI1)
Print Range
ou
OEgIE[:tiun
C Pages

Print Quality: |ﬁigh lé’ Copies: E:I

D Print to File Collate Copies

2 Select the desired print options and select OK.






Password

Passwords provide protection to functions that can permanenily
change the system configuration or have the potential for destroying
information at the remote equipment. Once the password function is
enabled, it will prevent any user without the correct password from
executing the requested function.

Note: If you do not assign a password to any functions, then all

users will have access to alt functions. Different functions can
be assigned different passwords.

Enabling a Password

To use the Passwords feature

1 Choose Password from the File menu. The following screen
will be displayed.

=| Pagswords

Unprotected Functions Protected Functions

Comm. Download
Edit Configuration

1 Change Passwerd... g

§upemser...§ | Accept g l Cancel g | Help §

Unprotected functions can be moved to the protected
functions box by highlighting one or both and selecting Move.



2

Modifv an Existing Password

5
6

Note:

Note:

Upon selecting Move, the New Password screen wilt be
displayed.

= Mew Password - Comm. Download

New Password: “ J

Re-Type New Password: ] |

(1] 4 r Cancel [ Help

Enter the New Password and Re-type it on the second line.

Passwords can be from 1 to 20 alpha-numeric characiers in
length. Passwords are not case sensitive.

Select OK. You will be returned to the Passwords screen.

Select Accept to enable the new password.

Chose Password from the File menu.

Highlight the Protected Function that you wish 1o change.
Select Change Password.

Enter the existing password and select OK.

Enter the new password twice and select OK.

Select Accept to enable the new password.

When selecting multiple functions their passwords must be the

same.

The user may select multiple functions.



Disabling a Password

1 Chose Password from the File menu.

2 Highlight the Protected Function that you wish to change to an
Unprotected Function. Select <- Move. Upon selecting move
you will be prompted for the current password. Enter the
password.

3 Select Accept.

Superuser

The Superuser function allows global access to all functions.
Superuser is an override feature. It can be used to enter all protected
functions or to remove passwords from the system (for example,
someone forgot their password).

The default Superuser password is RIS. If you decide to implement
password protection, you should change the default password as
soon as possible.

To change the Superuser password;

Select Password from the File menu.

Select Superuser.

Enter RIS.

Select Change Password.

Enter the new Superuser password twice and select OK.
Select OK.

Select Accept.
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To remove a password;

Select Password from the File menu.
Select Remove protection.

Select OK.

Select Accept.
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Keyboard Skills






Kevboard SKkills

This Appendix is iniended to be a basic guide for using Windows
without a mouse. It does not cover all Windows keyboard functions.
For more keyboard information consult your Windows documentation.

Application commands are listed on menus. Every application has its
own menus, with a Control menu common to all applications. The
Control menu, also called the System menu, opens from the small
box in the upper-left corner of each window. Other menus are
represented by names in the menu bar at the top of the application
window.

Selecting an Icon

To select an icon:

1 Press ALT W.
2 Select the application group by using the arrow keys.

3 Select the program icon using the arrow keys and press Enter.

Selecting and Canceling Menus

To select a menu:

1 Press ALT (or F10) to select the menu bar.

2 Press the left arrow or right arrow to select the menu you
want.

3 Press Enterto open the selected menu.

To cancel a menu:

1 Press ALT (or F10) to cancel the menu and move back fo the
application workspace.
or

1 Press ESC to cancel the menu but remain on the menu bar so

that you can select another menu.



Choosing Menu Commands

The items listed on menus are most often commands that represent
actions you want the application to carry out. They can also be
characteristics you assign to graphics or text, a list of open windows
or files, or the names of cascading menus, which are menus that list
more commands. No matter which items you wish to choose, you use
the same procedure.

To select an item from a selected menu:

1 Type the underlined letter in the name of the item you want.
You can use the up and down arrow keys to select the item
you want; then press Enfer.

Dialog Boxes

Dialog boxes request information from you and provide information to
you. The current option is marked by a highlight or dotted rectangle
(or both) around the name of the option or button.

To move within a dialog box:

1 Press TAB to move forward (generally left to right and top to
bottom) or Shift + Tab to move in the opposite direction.
or

1 Hoid down the ALT key and type the underiined letter in the
option name or group name

2 Within a group or options, use the Direction keys to move
from one option to another.

To choose a command button:
1 Press TAB to move to the command you want.

2 Press the Spacebar or Enter to choose the button and
complete the command.



Scroll Bars

Scroll bars allow you to view information that requires more space
than is available.

1 Press the Direction key that points in the direction you want
to scroll. Other scrolling options are listed in the following
table.
To Scroll Press these keys
One window up or down Page Up or Page Down
One window left or right Girl + Page Up or Cirl+ Page Down
To the beginning of a line Home
To the end of a line End

To the beginning of the document  Ctrl + Home
To the end of the document Cirl + End

List Boxes

A list box shows a column of available choices. If there are more
choices than can fit in the list box, scroll bars are provided so that you
can move up and down quickly through the list.

To select a single item from a list box:
1 Use the Direction keys to scroll to the item you want. Or type

the first fetter of the item you want. This will move you to the
first item that starts with that letter.

2 Press Enter to choose the item and complete the selected
command.

Drop-Down Boxes

A drop-down list box appears initially as a rectangular box with the
default choice highlighted in the box. The arrow in a square box at
the right opens into the list of available choices when you select it. If
there are more choices than can fit into the drop-down list box, scroll
bars are provided.

1 Press Aft+Down Arrow to open the drop-down fist box.

2 Use the Up or Down Arrow key fo reach the item you want,
and press Alt +Up Arrow or Alt +Down Arrow to select the
itemn.












alarm

CPU

D

deadband

E

extension

F

failsafe

intrinsic safety

L

linear output

LED

Glossary

A detected condition. Indicated by an LED on the front of the
module.

Central Processing Unit. In a digital computer, the section
containing the arithmetic and logic, control, and internal
memory units.

The range of values for which an applied control quantity (e.g.,
current or voltage) has no effect on the response of a circuit.

The period and up 1o three characters at the end of a filename.
An extension usually identifies the kind of information a file
contains.

Failsafe Mode is when the condition of a relay in the unpowered
(or shelf) state is equal 1o the alarm condition. This is also
referred to as the de-energized state.

Intrinsic safety is an design technique applied to electrical
equipment to prevent explosions in hazardous areas.

An output whose values can be represented by a straight line
on a graph.

Light emitting diode.

Glossary

1



M

millivolt

O

ohm

OPL

range

RTD

S

slide wire

T

thermocouple

trip
trip level

vV

voltage

2 Glossary

Abbreviation mV. A unit of low voltage; 1 mV = 102 V.

The basic unit of resistance, reactance, or impedance.

Organizer Programming Language.

The limits within which a circuit or device operates.

A transducer consisting of a specially made resistor whose
resistance varies linearly with temperature.

A simple potentiometer consisting of a single, straight piece of
resistance wire with a sliding contact.

‘A device consisting essentially of an intimate bond between two

wires or strips of dissimilar metals. When the bond is heated, a
dc voltage appears across it.

A relay output.

The value at which a trip/alarm is activated.

Electromotive force, or difference of potential. E = IR where | is
current and R is resistance.



Digital Power Measurement System

PROCEDURES FOR FACTORY REPAIR AND RETURN

A. Obtain a Returned Material Authorization (RMA) number by calling the
AMETEK Repair Department and giving the following information:

Model and Serial Number of the equipment.

Failure Symptom - Be Specific

Approximate date of installation.

The site name and address of the failed equipment.

i Complete shipping information for the return of the
equipment if other than the
operating site.

6. Name and telephone number of person to contact if questions
arise,

I SFAFN

B. Enclose the information with the equipment and pack in a commercially
accepted shipping container with sufficient packing material to insure that
no shipping damage will occur. Mark the outside of the container with the
RMA number.

Ship to the appropriate location:

Attention: Repair Deparlmen-t

AMETEK Power Instruments
255 North Union Street
Rochester, New York 14605 USA
Telephone: (888) 222-6282

- Fax: (716) 238-4097

C. Your equipment will be tested, repaired, and inspected at the factory.
Normal factory tum-around is ten working days or less (excluding shipping
time).

D. For emergency service or repair status information, please contact the
AMETEK Repair Department at {800) 881-4156.

WARRANTY — AMETEK warrants equipment of its own manufacture to be free
from defects in material and workmanship, under normal conditions of use and
service. AMETEK will replace any component found to be defective, upon its
return, transportation charges prepaid, within one year of its original purchase.
AMETEK will extend the same warranty protection on accessories which is
extended to AMETEK by the original manufacturer. AMETEK assumes no
responsibility, expressed or implied, beyond its obligation to replace any
component involved. Such warranty is in lieu of ali other warranties expressed or
implied.






RS TELEPHONE / FAX NUMBER LIST

ROCHESTER
SCIENTIFIC CBLUMBUS

This errata sheet provides an easy-to-use reference for all major depariments. Use these
numbers for ordering equipment, application assistance, technical support, and scheduling

field service.

Please Note: Your instruction manual may contain other phone and fax numbers; this list

will take precedence.

MAIN OFFICE
AMETEK Power Instruments - Rochester
255 N. Union St. Rochester, NY 14605

DEPARTMENT / PRODUCT LINE

TELEPHONE

FAX

MAIN PHONE

585-263-7700

085-262-4777

FIELD SERVICE

800-374-4835

585-238-4945

REPAIRS/RETURNS

888-222-6282

585-238-4945

SALES SUPPORT

800-850-6676

585-454-7805

Far East Office

AMETEK Power Instruments

271 Bukit Timah Road, #03-09
Balmoral Plaza, Singapore 259708
Tel: 65-732-8675

Fax: 65-732-8676

phoneametak.doc 11/01






